Posting an advert on Talentlink

Once your requisition has been fully approved you are ready to post your advert.

This document will show you how to post an advert on the Imperial College Jobs Site as well as the
Diversity Jobs Group job board and NHS Jobs job board (via Broadbean).

On the Imperial College Jobs site all advert postings appear live instantly and so do any amendments
you make appear instantly also.

If you have any questions or require assistance please contact support.jobs@imperial.ac.uk
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1. Saving the Job Description in a PDF Accessible Format

Before posting your advert, please ensure the Job Description has been loaded onto Talentlink in a

‘pdf accessible format’:

e Make sure the file is named after the job so “[Job title] Job Description”, this is an

accessibility requirement

e Convert it to PDF - File > Export > Create PDF/XPS Document - click options and tick

“Create bookmarks using headings”

< A « personal » neb115ic_ac_uk » Documents » Ol > Employer Brand Project » MNew Job Descriptions ~ O Search Mew Job Descriptions @
Organize *  Mewfolder =~ @
o) Name Date Modified Type Size
Qld JD Templates Folders
Assistant Teaching Fellow - Imperial Job ... Adobe AcrobatD...  92KB
=
L]
£
a
H
=]
v
File name: ‘ Assistant Teaching Fellow - Imperial Job Description Template “
Save as type: | PDF ~
[] Open file after publishing Optimize for: @Starjdard (pubhs_hmg Options...
online and printing)
O Minimum size
(publishing enline)
~ Hide Folders Toels - Publish Cancel
< v <« personal » neb115_ic_ac_uk » Documents » Ol » Employer Brand Project » New Job Descriptions v O Search New Job Descriptions @
Organize « New folder == - (7]
~ Mame Date Modified Type Size
Qld JD Templates
Assistant Teaching Fellow - Imperial Job ... Page range
OF
- () Cument page
() selection
(O Page(s) From: [4 =] To: [4 =
i Publish what
5 (® Document
J Document showing markup
d Include non-printing information
H Create bookmarks using:
(® Headings
l Waord bookmarks
@ Document properties
- Document structure tags for accessibility
PDF options
=]
[] PDF{A compliant
b D Optimize for image guality
| Bitmap text when fonts may not be
File name: ‘ Assistant Teaching Fellow - Imperial Job Description Template L d ~
| [ Encrypt the document with a pa rd
Save as type: | PDF ~
o
Open file after publishing Optimize for: (@) Standah sprany ' Uptrons.”-
online and printing)
(O Minimum size
(publishing enling)
~ Hide Folders Tools = Publish Cancel

Page | 2



1. Prepare your advert for posting

To prepare your advert please go to the posting tab and click on the arrow next to Job Advertisement,
then select Add New Job Advertisement:

i ~ TEST123 JOB - DO NOT APPLY(MED04369)
JOB CONTENT JOB APPROVAL PROCESS MATCHING CANDIDATES POSTING

Job Advertisement « Referral Proaram
Add New Job Advertisement

TESTJOB - DO NOT APPLY (UK Social Recruiting | Routing Rules Are Defined

In the pop up, please click on the IMPORT button and select Import from Job Description — this pulls
across the job title and advert text you previously included on the requisition form

ADD NEW JOB ADVERTISEMENT #5

IMPORT

Import from Job FRTIES

Description |
jred

Import from Job Ad
Template

Job Advertisement strapline

You are also able to add a strapline in this section if needed, we also suggest you should add here if
the role is however many hours if part time or/and if fixed term, for how long and that the salary
stated will be pro rata if part time, please see below:

EDIT THE JOB ADVERTISEMENT #5 b3

IMPORT
JOB ADVERTISEMENT PROPERTIES
Job Advertisement title required TEST123 JOB - DO NOT APPLY
Characters left: 123

Job Advertisement strapline this is a test

Characters left: 136

Please ignore the fields shown in the below screenshot, there is no need to input any information
here:
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Language required English (UK) X -

Translation set Please select e
Date Format dd/mm/yyyy X -
Company

City

Country United Kingdom X~
State/Province Please select -
Hide salary required No X -

Next, please populate the below mandatory fields — please ensure this information is correct as this
appears on the job advert and is used as search criteria by candidates, you will not be able to
proceed without populating these fields.

If any value is not present in the drop-down list, please email support.jobs@imperial.ac.uk with the
details of the drop down you would like created and this can be added for you.

Faculties required Faculty of Medicine x -
Departments required Department of Brain Sciences x -
Contract type work pattern required Full time - Fixed term X -
Salary or Salary range required Competitive x -
Salary required Competitive X T
Hide apply now button Please select -

You can also double check your advert information on this page under the different advert
headings/sections.

Please also ensure you tick the Job Description document at the bottom of this page as this allows
the document to be visible on the jobs site once the advert is posted. Ensure you job description
document is saved as [job title] Job description for example HR Partner Job description

Please then click SAVE.

ATTACHMENTS

Select All / Unselect All
Assistant Research Psychologist Job Description testing the upload and open.pdf &

[ test)D.pdf @

2. Posting the Advert on the Imperial College Jobs Site
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To post your advert, please click on the + icon on the left side of the screen and select post

ﬂ TEST123 JOB - DO NOT APPLY (UK): Social Recruiting

View content
Edit Job Advertisement
Edit Application Process

Edit posting comments

Manage Candidate Dispatcher
€ Send Job Advertisement by Email

Generate Job Advert Poster

Preview

Post

Delete

Routing Rules Are Defined

TYPE

In the pop-up that appears, please select the sites you wish to advertise on.

When advertising a role to everyone (both external and internal staff) you MUST ensure to select
both sites = Internal Career Site NEW AND External Career Site NEW.

When advertising a role to internal staff only you MUST ensure to only select the Internal Career Site

NEW.

Please click select next to each posting site (must be done one at a time) and include the posting
expiry date in the pop-up and click SAVE:

POST JOB OPENING

Job Advertisement TEST123 JOB - DO NOT APPLY

Select

Select

Select

Select

Select Preview

Select Preview

Distribute
Site Name

Broadbean (Corporate)

Agencies
Site Name
TPP - RD
TPP - 5]
Internal sites
Site Name

DO NOT USE Redeployment site db

Internal Career Site NEW

External sites
Site Name

External Career Site NEW
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POSTING INFORMATION

Posting Period
Start Date dd/mm/yyyy 18/07/2024 (3

End Date required dd/mm/fyyyy 15/08/2024 E

CANCEL “

Once posted for everyone (external and internal candidates) your screen should look like this:

TEST123JOB - DO NOT APPLY (UK): Social Recruiting (g f=n D m n Routing Rules Are Defined

START DATE SITES TYPE ONLINE VIA EMAIL STATUS END DATE ACTION
(5] 18/07/2024 External Career Site NEW External site Yes Na Published (3 15/08/2024 Fol X
(3) 18/07/2024 Internal Career Site NEW Internal site Yes No Published (3 15/08/2024 oY X

Once posted internally only (internal candidates only) your screen should look like this:

TEST123 OB - DO NOT APPLY (UK); Social Recruiting | Routing Rules Are Defined

START DATE SITES TYPE ONLINE VIA EMAIL STATUS END DATE ACTION

[ 18/07/2024 Internal Career Site NEW Internal site Yes No Published (3 15/08/2024 ® x

To edit your live advert, please click on the + icon and select edit job advertisement
E TEST123 |OB - DO NOT APPLY (U
View content
Edit Job Advertisement

Edit Application Process

Please make any amendments in the pop-up that appears and click SAVE. Changes should be visible
instantly on the jobs site.

To amend the closing date for your live advert, please click on the career site link and amend the
closing date in the pop-up that appears and click SAVE. If the advert is posted on both the external
and internal site, this must be done twice.

TEST123 JOB - DO NOT APPLY (UK){ Social Recruiting E D m u Routing Rules Are Defined

START DATE SITES TYPE ONLINE VIA EMAIL STATUS END DATE ACTION

[5) 18/07/2024 External Career Site NEW External site Yes No Published {3 15/08/2024 (o) X

EndDate required aaimmiyyyy ajonfsoze (9

POSTING HISTORY.

cance “
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If you wish to pull off your advert early you can do so by clicking on the X icon on the right side of

the screen

Routing Rules Are Defined

TEST123)0OB - DO NOTAPPLY (UK); Social Recruiting E u m ﬂ n

START DATE SITES TYPE ONLINE VIA EMAIL

m 18/07/2024 External Career Site NEW External site Yes No

STATUS END DATE

Published (3 15/08/2024

PLEASE NOTE: if and when pulling off an advert as the post has been cancelled, please also ensure to

directly contact all applicants that have submitted an application informing them of this. Please also

remember to change the job status accordingly.
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3. Posting the Advert on the Diversity Jobs Group

Please note before you use Broadbean the role has to be published to the Imperial College jobs
site.

We suggest you have the external live advert open in another tab to easily copy and paste
information.

All jobs being posted externally should be posted on Diversity Jobs also. We have unlimited postings
and currently there is no charge to departments.

To post your advert, please click on the + icon on the left side of the screen and select post

TEST123 JOB - DO NOT APPLY (UK): Social Recruiting | Routing Rules Are Defined

View content

Edit Job Advertisement TYPE

" Edit Application Process
Edit posting comments
Manage Candidate Dispatcher

© send Job Advertisement by Email
Generate Job Advert Poster
Preview
Post

Delete

Please select Broadbean (Corporate), in the pop-up please click on the first tile — Diversity Jobs
Group and click Continue

POST JOB OPENING
Job Advertisement TEST123 JOB - DO NOT APPLY

Distribute
Site Name

Select Broadbean (Corporate)

POSTJOB

N4

o Choose Job Boards

Please cick the job board logos to post this advert fo

O ausites Below

edit subscription | set posting limits

0 Diversity Jobs Group

JOBS GROUP

Use this for every job being advertised
externally!
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Please ensure to complete all the mandatory fields as shown below:

e Under Broadcast as please select Imperial College
e Under Industry Sector please select the sector/group this post lies in

Broadcast As: #* Imperial College ¥

Main Advert Information

Reference No. #* MED04369

Job Title * TEST123 JOB - DO NOT APPLY

Job Type and Specifics

Job Type Permanent v

Full/Part Time

Full-Time

Diversity Jobs Group Job Category

Industry and Sector Information

Industry Sector * Admin and Secretarial v

e Under Salary + Benefits please type in the salary range/fixed salary
e Under Hide Numeric Salary on Job Boards please select No

e Under Location Information please select Europe > England > London and type in the

Campus post code (please see postcodes below)

South Kensington Campus — SW7 2AZ
White City Campus - W12 7TA
Hammersmith Campus - W12 ONN
Charing Cross Campus - W6 8RP

St. Mary’s Campus - W2 1PG

Chelsea and Westminster - SW10 9NH
Royal Brompton Campus — SW3 6NP
Silwood Park — SL5 7PY

Salary and Benefit Information

Salary + Benefits r 4 ] - Additional benofits
Salary description that will be displayed M| <EE 46563 annum ~ | Adaltional benemts
on your advert e.g. car, pension, negoliable

Hide Numeric Salary on Job Boards?
*

Location Information

Location Europe > England > London

Postcode/Zipcode of Job Location W7 2,
(Mandatory) * SW7 24Z
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Under Main Description Duties, please ensure your advert text is correct, here you can add in
the closing date (as highlighted below) and then run the spell checker in order to proceed to
the next step. Then click Continue.

Main Description Details

Detailed Job Description *

B 7 U |= = = = Paragraph ~ FontSizes -
Xhe HESES=ELR A—L T~
Degree or equivalent,_ preferably in science of healthcare subject -

Experience of managing projects and working in research environment
Excellent interpersonal communication skills

Excellent numeric skills and financial management experience

Ability to prioritise work appropriately

Further information
This is & part-time {up to 0.7FTE), fixed term contract which is available until 31 December 2028,

Hybrid working may be considered for this role and the opportunity for hybrid working will be discussed at interview.
Staff working in roles that are suitable for hybrid working will normally be expected to work 60% of their time onsite.

Should you require any further details on the role please contact: Mr Dilesh Shah, Section Manager &dult Infectious
Dizease, dilesh.shah@imperial.ac.uk or Professor Sriskandan s.sriskandan@imperial.ac.ulk

Closing date: 30th July 2024, 23:59pm (BST)

Characters: 3295 /60000 HTML Characters: 3705 / 60000
Please note: you should never include contact details in the description of the advert, these will be sent separately

e Under Cost Centre, please type in the number 0
Cost Center 0
IMazx limit characters 32 / Maximum Length is 32 Characters
e Under Contact Details, you may remove your email address.
Please ensure you paste the correct live link to your advert posted in the Imperial College
EXTERNAL Jobs Site
[ ]

Under Advertising Period, please state the number of days you would like this advert to be

live on Diversity Jobs. The role will no longer appear on Diversity Jobs as of that date (e.g. in
7 days’ time).

Contact Details

Contact Name Gabriela Sinu

Contact Email Address g.sinu@imperial.ac.uk

Contact Telephone Number

Contact Fax Number

Apply Online URL * https:/iwww.imperial ac.ukfjobs/search-jobs/description/index | check apply online url

Advert Cost

Total cost

Destinations & Advertising Periods

Diversity Jobs Group
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Once you are happy with all the advert information, please click on SEND ADVERT

>
Send Advert

Once posted you will be able to see your advert has been published on Diversity Jobs Group on
TalentLink:

TEST123 JOB - DO NOT APPLY (UK){ Social Recruiting E-P u m n u Routing Rules Are Defined

START DATE SITES TYPE ONLINE VIA EMAIL STATUS END DATE

[3) 18/07/2022 External Career Site NEW External site Yes No Published [5) 15/08/2024
[%) 18/07/2024 Internal Career Site NEW Internal site Yes Ne Unposted [ 18/07/2024
{5 18/07/2024 Broadbean (Corporate) EroadBean Distribution - - Published o]

1% 18/07/2024 Diversity Jobs Group Via BroadBean Distribution E - Published o]

You can also view your live advert by following the below link:

https://diversityjobsgroup.com/imperial-college-london/

Some notes to keep in mind when posting on Diversity Jobs Group:

e When a job is posted it will come off the site within the amount of days as stated on the
broadbean form drop down field, not the actual closing date on our site.

e Job upload timings are: 11am, 3pm and 6pm Monday- Friday

e Ifajobisunposted (e.g. went to advert by mistake) it will be taken off at 11am, 3pm or 6pm
Monday- Friday

e Please contact support.jobs@imperial.ac.uk for any urgent amendments to adverts
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4. Posting the Advert on NHS Jobs

Please note before you use Broadbean the role has to be published to the Imperial College jobs
site. NHS Jobs is typically only used for certain roles and users within Faculty of Medicine.

We suggest you have the external live advert open in another tab to easily copy and paste
information.

To post your advert, please click on the + icon on the left side of the screen and select post

TEST123 JOB - DO NOT APPLY (UK){ Social Recruiting | Routing Rules Are Defined

View content

Edit Job Advertisement TYPE
Edit Application Process

Edit posting comments

Manage Candidate Dispatcher

(o]

Send Job Advertisement by Email
Generate Job Advert Poster
Preview

Post

Delete

Please select Broadbean (Corporate), in the pop-up please click on Diversity Jobs Group (as every
externally advertised role goes on this job board) and NHS Jobs and click Continue:

POST JOB OPENING
Job Advertisement TEST123 JOB - DO NOT APPLY

Distribute

Site Name

Select Broadbean (Corporate)

0 Choose Job Boards
Please
O A sites Below
edit subscription | set posting limits edit subscription | set posting limits
Diversity Jobs Group NHS Jobs
] NHS
_y Jobs
JOBS GROUP
YOU CAN USE THIS AT NO COST &
Use this for every job being advertised REMEMEER TO GO AND TIDY UP THE
externallyl JOB AND POST JOB VIANHS.JOBS

LOGIN ALSO!

Please ensure to complete all the mandatory fields as shown below:

e Under Broadcast as please select Imperial College
e Under Job Type please pick Permanent or Fixed Term
e Under NHS Jobs Number of Hours/Sessions Per Week please leave this field blank
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e Under NHS Jobs job type please pick Permanent or Fixed Term

e Under Date Applications Close please type in job closing date

e Under NHS Jobs Work Pattern Units please select Hour

e Under the Industry and Sector Information section please select the industry sector/area of
work/staff group to match as closely as possible to this role

e Under the Salary + Benefits please type the salary range per annum

e Under Hide Numeric Salary on Job Boards please select no

e Under NHS Jobs Pay Scheme Type please select Other

Broadcast As: * Imperial College v

Main Advert Information

Reference No. * MED04368

Job Title * TEST123 JOB - DO NOT APPLY

Job Type and Specifics

Job Type Permanent w

NHS Jobs Job Type *

Permanent v
NHS Jobs Number of Hours/Sessions
Per Week
NHS Jobs Work Pattern Types * Full Time -
Date Applications Close * 01/09/2024
e.g. 22/06/2020
NHS Jobs Work Pattern Units * Hour v

Industry and Sector Information

Industry Sector * Admin and Secretarial v

NHS Jobs Area of Work * Administration -

NHS Jobs Staff Group * Administrative and Clerical w

Salary and Benefit Information

Salary + Benefits £ v 30000 | 40000 || annum v |Additional benefits
Salary description that will be displayed
on your advert. e.q. car, pension, negotiable

Hide Numeric Salary on Job Boards? N,

o v
*

NHS Jobs Pay Scheme Type * Other
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e Under the Skills and Experience section please copy and paste your advert information into
the relevant boxes. We suggest populating all boxes/sections if possible, however the
mandatory fields are:

NHS Jobs Essential Qualifications
NHS Jobs Essential Experience
NHS Jobs Main duties of the job

Skills and Experience

NHS Jobs Essential
Qualifications *

Characters:0 (max 10000)

NHS Jobs Desirable
Qualifications

e Under Location please select Europe > England > London

e Under Location Street Address please type out Campus address job is located at

e Under NHS Jobs Police Convictions: please select correct option from the dropdown

e Under NHS Jobs Police Warnings: please select correct option from the dropdown

e Under NHS Jobs Disclosure and Barring Service (DBS): please select correct option from the
dropdown

e Under NHS Jobs Sponsorship: please select no
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e Under NHS Jobs Registration: please select no

Location Information

Location * Europe = England > London

Location Street Address =* Exhibition Road. London

Street Address of the job location

Postcode/Zipcode of Job Location _
(Mandatory) * SWT 2hZ

Client and Applicant Information, etc.

NHS Jobs Police Convictions Not Applicable ~

NHS Jobs Police Warnings s

No v
NHS Jobs Disclosure and Barring No w
Service (DBS) * :
NHS Jobs Sponsorship * No v
NHS Jobs Registration * No v

e Under the Main Description Details section please copy and paste advert details accordingly.
Please also remember to run the spell checker (highlighted in yellow below) to proceed to
the next page. Once ready please click continue.

Detailed Job Description #* B 7 U = = = = Paragraph ~ FontSizes =~

XhhE H ESES=E &8 AY—L T~

Job summary

TEST DO MOT APPLY

Duties and responsibilities
TEST DO MOT APPLY
Essential requirements
TEST DO MOT APPLY

Further information

TEST DO NOT APPLY

Characters: 161 /10000 HTML Characters: 278 / 10000

Please note: you should never include contact details in the description of the advert, these will be sent separately

Once ready please click continue, you will then be taken to the Preview + Send tab. Here you can
review the details of the advert. If you spot a mistake, click the Go back button at the bottom of the
window and make your edits.

e Under NHS Jobs Contract Count please type in the number of months the contract is
available for if the role is fixed term, please only type in the number and not unit. For
instance, rather than typing in 12 months, please only type 12.

e Under NHS Jobs Contract Unit please select Month

e Under Cost Centre please type 0

e Under Contact Details please remove your email address
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e Under Apply Online URL please ensure to include the advert link from the Imperial College

Jobs site. This is crucial to ensure that interested applicants are re-directed to the Imperial

Jobs site to submit an application.

Contact Details

Contact Name Gabrigla Sinu

Contact Email Address g.sinu@imperial.ac.uk

Contact Telephone Number

Contact Fax Number

Apply Online URL * https:/fwww.imperial. ac.ukfiobs/search-internal/description/inde| check apply online url

When ready please click on SEND ADVERT at the bottom of the page, this will send the advert to the

NHS Jobs page where you will need to complete the posting.

Please use this link to login https://www.jobs.nhs.uk/employer/auth/login

Once logged in please click on drafts where you will be able to locate your advert, then please click

on complete the listing.

You're viewing Imperial College London

Signed in as Gabriela Sinu  Sign Out

113 1.Y Your feedback will help us to improve this service.

Imperial College London

Dashboard

Tasks by stage Listings by user

What you can do

Create a job listing

Search for a listing

Showing tasks for Search for an applicant
All users v|
Draft 4 - on track 2, overdue 2 Manage the account
I Manage users
Published 2 At risk applicants
I Accredited logos

Key performance indicators
Shortlisting 67 - on track 14, overdue 53 (KPIs)

Draft

Job title Date started Task What needs doing next
TEST123 Job advert headings - DO NOT APPLY 22 Jul 2024 Draft Complete the listing or
N0047-24-0015 Delete the listing
ACA00306

TEST123 JOB - DO NOT APPLY 22 Jul 2024 Draft Complete the listing or
N0047-24-0030 Delete the listing
MEDO04369
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Once you click on complete listing, you will be taken to a page where you will need to check each
section of the advert to ensure the information has pulled through correctly. Although each section
will already have the word ‘completed’ next to it, please ensure to still check it, there’s 12 sections to
check in total.

Job listing complete

You have completed 12 of 12 sections.

Add the job title

Job title and reference number COMPLETED

Add the details of the job

About the job and pay COMPLETED
Location
Contact details and closing_date

Some points to keep in mind when completing these sections have been included below:

e Contact details: these will default to yours, please ensure to change these details to the ones
included in the further information section of the advert

Name

|Gabn’e|a Sinu |

Job title (optional)

|Recruitment System Coordinator |

You can enter an email address, telephone number, or both

Email address

|g.sinu@imperial.a(.uk |

Telephone number
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e Supporting Information: please click ‘yes’ to upload the Job Description. Under the
document name field please type out Job Description and Person Specification

Do you want to add supporting information
to the advert?

TEST123 JOB - DO NOT APPLY

Reference no: MED04369
NO047-24-0030

You can add supporting documents and links to this advert. These could
help applicants decide whether to apply.

@ Ow

e Select No to Pre-application questions
e Select No to Additional application questions
e Select No to Internal Documents

TEST123 JOB - DO NOT APPLY

Reference no: MED04369
N0047-24-0030

The file you choose must

« not be larger than 1MB in file size

* be a DOC, DOCX or PDF

Upload a file

Choose File | No file chosen

What do you want to call this document?

Use a name that applicants will understand. For example, Working for the

London Ambulance Service

[10b escription and person specification

Upload document

Once each section has been checked please click on the link (highlighted in yellow below) to preview

what your live advert will look like.

Make sure the details are correct before publishing. You can also preview
the job advert (opens in a new tab).

If you are happy with the advert preview and are ready to post your advert on NHS Jobs, please click

on the Publish Now button at the bottom of this page:
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Once published, the following pop-up will appear confirming your advert has been published and is
now live, this will also include the live link to the advert which you can share with the Hiring Team.

EE v semcncs will nelz ws v imprave this service.

Job advert published

“fou have created = job advert for
MHS jobs broadbean tester.

The reference number iz

N0047-23-4126

\iew the advert as seen by applicants (opens in a new tab).

We strongly suggest you click on the ‘apply for this job’ button to test whether the re-direction to the
Imperial College Jobs site works correctly:

Clinical Trial Manager

Imperial College London

The closing date is 22 July 2024

If you have any queries or technical issues or need access to the NHS jobs site, please email
support.jobs@imperial.ac.uk.
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